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Introduction  

Q increases the speed and accuracy with which market research surveys are analyzed.  

Learning more about Q  and support  

The quickest way to find something out is to click on the Help menu and select 

Online Documentation Search.  This takes you to a web page where you can search 

through Qôs documentation. 

The easiest ways to learn how to use Q are to either read this guide or to complete 

the online training ( click on Help and Online Training).  Training is also available via 

web meetings for a fee.  

If you wish to understand what a particular option in Q does, either press the F1 

button on your keyboard, click on the Help button on a dialog box , or click on the 

Help menu and select the first option ( the one with the   to the left of it; the first 

option will always be the help for whatever is on the screen).  Click on the Search tab 

in the help to search for specific terms.  

You can also get support by sending an email (click on Help and Email Supporté).  

If your request is a standard problem, it will be quickly explained or you will be 

referred to appropriate documentation or training materials.  If your problem is new 

or unusual, a document will be prep ared showing the steps required to complete the 

task. 

Obtaining Q  

Q can be downloaded from your customer page.  If you do not know the address of 

your customer page please contact support@q-researchsoftware.com. 

License files  

A license file needs to be installed in order to use Q properly.  If the license file has 

not been installed, Q will operate with limited functionality  (and will be called Q 

Reader).  The license file is obtained from your customer page or by contacting 

sales@q-researchsoftware.com.  Q license files have a file extension of .qlic  (e.g., 

your company name license.qlic ).  Double click on the Q license file to install 

a license. 

mailto:support@q-researchsoftware.com
mailto:sales@q-researchsoftware.com
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Checking for new versions of Q  

The first time Q is opened each day, it automatically checks for new versions.  If your 

network/internet setup blocks this, you can manually check whether a new version of 

Q has been released by clicking on Check for New Version of Q in the Help menu.  

An internet browser window will open with the results of the check.  You will either be 

notified that you are already running the latest version of Q, or that there is a new 

version available.  If  a new version is available, the key changes that have occurred 

since the last version will be listed and you will be given the opt ion to download the 

new version.  You should always download the most recent version as it will contain 

bug fixes and other improvements. 
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Getting started  

Start Q by double-clicking on either the  icon on your desktop or the icon located 

in Windowsô Start menu. 

Getting data for use in Q  

Most Q projects involve the analysis of survey data.  Q supports all the main file 

formats for survey data.  However, the ease with which you can use Q will be partially 

determined by the data file that you are using.   

We recommend that you obtain data in one of the following file formats:  

Ý SPSS data files (file extension of  .sav ).  If requesting an SPSS data file from 

another company it is recommended that you send them the SPSS data file 

specifications, which can be obtained from http://www.q -

researchsoftware.com/support.aspx.  

Ý Triple-s files (.sss  and .asc  or .csv )  

Ý IBM SPSS Data Model files (.mdt ).   

Additionally, Q can read CSV Files (.csv ), some SPSS Syntax files (.sps ) and SQL 

databases.  However, none of these files formats is recommended and each will 

involve substantially more effort for the user.  In particular, CSV files and SQL 

databases do not contain much of the information that is needed for analyzing survey 

data and, as a result, the user will have to enter this information into Q.   

If your data is in  an Excel file you can convert it to a CSV file by opening it in Excel 

and selecting Save asé from the File menu and then selecting the Save as type as 

CSV (Comma delimited) (.csv). 

Starting a project  

Q uses two different files: a data file, which contains the data from a market research 

study, and a Q Project File which stores all of your work in Q (e.g., tables you have 

created). 

To start a project, select Import New Data File (New Project)é from the File menu 

and select a data file you wish to analyze in Q.  You may be asked Would you like Q 

to tidy up SPSS variable labels?  If you select Yes, which is usually appropriate, Q 

will strip out any repetitive text that appears in labels within a multiple response 

question (e.g., if the labels were Satisfaction: Citibank and Satisfaction: Bank of America, 

Q will replace these with Citibank and Bank of America).  Q will then ask Would you 

http://www.q-researchsoftware.com/support.aspx
http://www.q-researchsoftware.com/support.aspx
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like Q to automatically group alike variables to create multiple response 

questions?  It is generally a good idea to select Yes.  More detail about setting up 

projects is contained in Data manipulation and preparation , page 43, and the Q 

Reference Manual. 

Saving and opening projects  

Projects are saved using either Save Project or Save Project Asé in the File menu.  

Once you have saved a project, re-open it by selecting Open Existing Projecté from 

the File menu.  That is, while a project is started by importing a data file, once the 

project has been started you do not need to import the data again.  Q will 

automatically read the data file associated with your project.  

The rest of this guide explains how you can use Q to analyze data.  All of your work is 

saved as a Q Project File, which has a file extension of .Q .  Q makes no modifications 

to the underlying data itself ï this makes it easy to update reports with new data (see 

Updating tables with new or revised data , page 52). 

The Tables, Variables and Questions, Data and Notes tabs  

When you start Q, you are in the Tables tab; this is where most data analysis is 

performed.  Change tab by clicking on the tabs at the bottom left of the screen          

( ).  The Variables and Questions tab is used to 

reorganize the data (e.g., grouping together variables, creating complicated filters, 

recoding).  The Variables and Questions tab is discussed in more detail in Setting 

questions, page 48 and following, the Q Reference Manual and Help u Online 

Trainingé.  The Data tab shows the raw data; it is discussed in mo re detail on page 

43.  Notes can be written in the Notes tab. 

Multiple data files  

You can analyze multiple data files at the same time.  Additional data files are added 

by selecting File u Add Data File to Projecté.  Plots can be created using data from 

different data files provided that both files contain a Date question with identical  

variable names and question names.  The relationships between data files are set 

using File u Edit Data File Relationshipsé. 
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Creating tables  

Tables are created by selecting questions in the blue and brown drop-downs on the 

Tables tab ï see Figure 1. 

 

Figure 1.  Blue and brown drop-downs 

There are three ways that you can select questions using the drop-downs: 

Ý Click on the  to the right of the drop-downs and select the question using your 

mouse. 

Ý Click in the drop-down and use the cursor keys on your keyboard to select the 

question and press the Enter key on your keyboard. 

Ý Click in the drop-down, type a word or phrase and select from the questions 

containing the typed word or phrase .  For example, Figure 2 shows three 

questions all containing age. 

 

Figure 2.  Quicksearch example 

Figure 3 shows a table produced by Q (in some other programs this is called a 

Frequency Table).  There are a couple of key things to note a bout this table:  

Ý Using an expert system, Q has automatically deduced that the appropriate way 

of looking at the data is to use percentages. 

Ý Rather than show a Total, Q shows a NET.  If this was a single response 

question the NET would be 100% and it would be the same as a total.  

However, with multiple response data, such as that shown in this table, the 

NET is not guaranteed to add up to 100%, as it is possible that some people 
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will have been shown a question and not selected anything (as occurred with 

100% - 99% = 1% of the respondents in this example).    

    

Figure 3.  SUMMARY table 

Another example of a table is shown in Figure 4.  In this case, rather than showing 

percentages, Q has automatically chosen to compute the average (also known as the 

mean).  Q does this when the data is numeric rather than categorical.  Additionally, 

instead of showing a NET, the table now shows a SUM, which is literally the sum of 

the values in the table.
1
  When Q displays categorical data it shows a NET and when it 

displays numeric data it shows the SUM. 

 

Figure 4.  Comparison of means 

The two tables we have just looked at were both created by selecting a question in 

the blue drop-down with SUMMARY selected in the brown drop-down.  We can 

create a crosstab by selecting questions in both the blue and brown drop -downs (see 

Figure 5). The color-coding in the tables indicates statistical significance; with a blue 

color indicating that the numbers are significantly high and red indicating that they 

are significantly low. Arrows also indicate the statistical significance of the cells; the 

                                        

1
 SUM and NET are computed using observations for which there is complete data.  Where no respondents answered all the 

questions/items, SUM and NET will show NaN. 
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length of the arrow indicates the degree of statistical significance relative to the other 

cells in the table.  Significance can also be shown using font size.  See Tests of 

statistical significance, page 54. 

 

Figure 5.  Aided Awareness by BANNER 

Figure 6 shows a table where the significance testing is represented by letters; these 

are selected by right-clicking on tables and selecting Statistics ï Cells and Column 

Comparisons.  To display the Column Names, right -click and select Statistics ï 

Below and Column Names. This table is also an example of a two-dimensional 

question.  It is ñtwo-dimensionalò because displaying the question as a table requires 

both rows and columns. 

 

Figure 6.  Attitude data  
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Figure 7.  Attitude data ï top 2 boxes 

With two-dimensional questions it is often useful to recode them into one -dimensional 

questions.  Figure 7 shows an example of this, presenting the Top 2 box scores for 

the attitudes  (i.e., the sum of Strongly agree and Agree a little; this can be setup in the 

Variables and Questions tab ï see Worked Example 5: Setting Multiple Response 

Questions, page 48).  The Q Reference Manual and Online Training contain 

extensive detail on how to set and change question types. 

The blue drop-down is used to select the question that will appear in the rows.  The 

brown drop-down is used to determine how you wish to break down the results of 

that question. Using the brown drop -down, you can also choose RAW DATA  (i.e., the 

underlying data used to construct tables), a SUMMARY  of the information (e.g., the 

percentages in each category) or select another question to see the interrelationship 

between two questions.  If your data is text (e.g., verbatim responses from an open -

ended question), you will only have the option of viewing it as RAW DATA , unless 

you change the Variable Type  in the Variables and Questions  tab or code the 

data (see Coding, page 63). 
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Worked Example 1: Creating tables  

 

Figure 8.  SUMMARY of BANNER 

1. From the File menu select Open Existing Projecté.  

2. Select Phone 1.Q , which will be in c: \ Program Files \ Q\ Examples  (unless Q 

has been installed in a different location on your computer).  
 

This project contains data on mobile phone ownership and usage. The table in 

Figure 8 shows the percentage of the sample in each category. For example, 61% 

of the sample is aged less than 35 years and 26% have Telstra as their current 

provider. 

3. Click on the blue drop -down and select Q6. Aided Awareness.  The resulting 

table shows the percentage of people who are aware of each of the mobile phone 

companies (e.g., 91% of people have heard of Optus). 

4. Click on the brown drop-down and select BANNER.  You have now created what 

is commonly known as a crosstab (see Figure 9). By default, this table is 

presenting column percentages (this is indicated at the top left of t he table).  That 

is, the table shows the percentage of people in each demographic group (columns) 

who are aware of the mobile phone companies (rows).   
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Figure 9.  Aided awareness by BANNER 
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Working with tables  

Q enables you to quickly and accurately modify tables to help you discover and 

present findings. This chapter provides an overview of the basics of using Q to 

manipulate tables. In this chapter you will learn how to:  

Ý Move and change rows and columns in tables. 

Ý Select different statistics to view (e.g., percentages, n, etc.).  

Ý Deal with missing values. 

Ý Format cells. 

Ý Create spans, grouping together rows or columns. 

Ý Create banner questions. 

Ý Customize the names of statistics on tables and plots. 

Moving and changing ro ws and columns  

When viewing any table, you can move rows and columns by dragging-and-dropping 

(i.e., click on the row or column of interest and drag it to where you would like it to 

be).  Merging is done in the same way, except that you drag one category on top of 

another and release your mouse button (i.e., ódropô one category onto another).  

Figure 10 shows a new version of the table first introduced in Figure 6 (if you wish to 

reproduce this example, open Phone 1.Q  which will be in c: \ Program 

Files \ Q\ Examples  and select q23. Attitudes in the blue drop-down).  It has been 

created by: 

Ý Copying the Strongly agree category and placing it immediately to the left of the 

original Strongly agree category (hold the Ctrl key down, click on the cell and 

drag ï a small box appears saying   when you are about to copy).  

Ý Copying the Agree a little category onto the copy of the Strongly agree category 

(i.e., while holding the Ctrl key down, dragging Agree a little onto the copy of 

Strongly agree and releasing when the box saying Copy Onto appears).  This 

resulted in a category called Strongly agree + Agree a little. 
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Figure 10.  Attitude data  

Ý Renaming Strongly agree + Agree a little as Top 2 Boxes (right -mouse click on the 

category, select Renameé, type the new name and press OK).  Note that 

there are other options available in this menu and  also that the options 

available depend upon the data being shown. 

TIP: These three steps could have been done more quickly by selecting the 

two categories, right -clicking and selecting Create NET. 
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Ý Sorting the table by right -clicking on Top 2 Boxes and selecting Sort By ¤ 

Values ï Descending¤Row % . 

Ý Changing the widths of the columns and heights of the rows by dragging the 

lines in-between the rows and the columns (as is done in Excel). 

If you inadvertently merge categories, you can unmerge them by pressing , clicking 

your right mouse button on the category and selecting Split, or, if you wish the table 

to appear as it did prior to editing, you can select Revert. 

Selecting statistics (n, Row % , Column %, etc.)  

Q has an expert system which automatically selects the most appropriate statistics to 

show on a table.  Most commonly, these are percentages and averages.  Alternative 

statistics can be shown within each cell, to the right of the table or below the table.  

These statistics can be selected by right-clicking on the table and selecting from 

within Statistics ï Cells and, on some tables, also from Statistics ï Right and 

Statistics ï Below. 

      

Figure 11.  Unaided Awareness data with various statistics selected 

The table on the left of  Figure 11 shows column percentages. It is the default way 

that Q displays crosstabs of categorical questions. The table on the right shows the 

column percentages but also shows the count in each cell of the table, n. The second 

table was created by: 

Ý Creating the table on the left.  
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Ý Right-clicking the mouse on the table and selecting Statistics ï Cells and 

then n. 

Ý Pressing the  button on the tool bar , which displays a percentage sign next 

to any percentages. 

Note that the top -left of th e table indicates the statistic(s) displayed on the table (e.g., 

Column %, n).  

Figure 12 shows a table where Average and Row n have been selected from 

Statistics ï Right. 

  

Figure 12.  Attitude data with categories, averages, and sample size shown 

Missing values  

Q automatically filters data that have been classified as missing values in the raw data 

file.  

To modify which values are automatically filtered, right -click on the blue or brown 

categories shown on the table, select Valuesé to open the Value Attributes dialog 

box, and ensure the appropriate categories are checked as Missing Data. 

If you wish for a category to be in cluded in the calculation of percentages but for it to 

be excluded from the calculation of averages, replace its Value  with NaN and do not 

check it as Missing Data. 

Formatting cells  

You can increase or decrease the number of decimal places, show percentage signs , 

hide rows and columns with only zeroes and color the background of cells to highlight 

interesting results by using the formatting toolbar buttons ( ).  If you 

wish to set different numbers of decimal places for different statistics, right -click on 

the table, select Table Optionsé, click on the Decimals Places tab and set the 

number of decimals as desired.  If you wish to make these changes to every table, do 

this via Edit ¤ Project Optionsé ¤ Decimal Places. 
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Worked Example 2: Merging, Moving and Renaming Rows and Columns  

1. From the File menu select Import New Data File (New Project)é. 

2. Select the Pasta Sauces including screenouts.sav  data file which will be 

in c: \ Program Files \ Q\ Examples  (unless Q has been installed in a different 

location on your computer).  

3. Click Yes when Q alerts you that that your data has not been completely set up.  

4. Click on the blue drop-down and select Age. How old are you?  Your screen 
should now look like Figure 13. 
 
Note that the brow n drop-down has also changed and shows SUMMARY . This is 
the default when displaying everything that is not text.  
 
Also note that Q has colored the numbers on the table, using blue to highlight 
numbers that are relatively high and red to highlight numbers t hat are relatively 
low. In this case, each number is being compared to the average of all of the 
percentages other than the NET.  

  

Figure 13.  Frequency of age 
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5. Right-click on the table, select Statistics ï Cells and select n. 

6. Place your mouse on Less than 18.  Hold down your left mouse butt on down and 

drag onto 18 to 24.  Note that a small box appears saying  or  

depending upon the location of your mouse pointer.  Release your mouse when 

the cursor is on 18 to 24 and the two categories are merged (with all the 

corresponding numbers automatically updated), and renamed as 18 to 24 + Less 

than 18. 

7. Hold your Ctrl button down and use your mouse pointer to click on 18 to 24 + Less 

than 18, 40 to 44, 45 to 49, 50 to 54, 55 to 64 and 65 or more. 

8. Right-click on one of these categories and select Mergeé. 

9. Type Other and press the Enter key on your keyboard. 

10. Click on the Other row category and drag it to in -between 35 to 39 and NET.  Your 

table should now look like Figure 14.   

  

Figure 14.  Table with merged and moved categories 

11. Right-click on the table, select Statistics ï Cells and deselect n. 

12. Right-click on any of the row categories and select Revert, which restores the age 

categories to how they were before you moved them around.  

Spans  

Row and column categories can have one or more spans placed above them (see 

Figure 15).  To create spans, first select the headings of interest (holding down Shift 

or Ctrl and clicking with the left mouse button), then right -click and select Create 

Spané.  Spans can be moved and resized by dragging and dropping. 
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Figure 15.  Example of span 

Creating Banner  Questions  

It is often useful to combine multiple questions together so they can be selected 

simultaneously.  For example, Figure 16 shows a table where the brown drop -down 

contains a banner, which includes age and gender. 

 

Figure 16.  Example of a banner question (shown at the top of the table)  

Such a banner is created by selecting Create4Banneré and dragging the questions 

of interest from the left to the right of the dialog box ï see Figure 17.  Where 

questions are placed side-by-side, they will appear side-by-side in the resulting banner 

question.  If placed on top of each other, Q will nest the questions (e.g., create a 

category of Males aged 18 to 24). 

More complicated banner questions can be created using the methods for creating 

new variables that are described in the Q Reference Manual.  

Some types of questions cannot be selected in the Create ¤ Banneré dialog box.  In 

particular, you can only select questions that are Pick One or Pick Any.  See page 

Question Types, page 46 and following, for detailed information on the meaning of 

the different types and a worked example illustrating their uses; more information is 

in the Q Reference Manual and Online Training. 
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Figure 17.  Create Banner dialog box 

Customizing the names of statistics on tables  and plots  

It is possible to customize the names of statistics on 

tables and plots.  The table on the right has been 

customized to show statistics in the Chinese language. 

To customize statistics for an entire project, select Edit 

4Project Options and click on the Output Text tab.  Enter the desired names in the 
Override Text column. 

You can also change the text shown for selected tables by selecting Edit 4Table 

Options, clicking on the Output Text tab and making the changes.  
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Weighting  (sample balancing ) 

Weights are applied in the Weight drop-down at the bottom of the screen .  Different 

weights can be applied to different tables in a project.  Press  to remove a weight . 

In addition to the drop -down, the presence of weighting is also reflected in the 

sample size description at the bottom of the screen.   

base n = from 151 to 215; total n = 223; 72 missing; effective sample size = 156 (70%); 80% filtered out  

Figure 18.  Sample size description with weighted data and a filter  

The description in Figure 18 indicates that:  

Ý The sample size varies for different cells in the table, the cell with the smallest 

sample size being 151 while the largest cell has a sample size of 215.  (We can 

see each cellôs sample size by selecting Base n from Statistics ï Cells  ï see 

Selecting statistics (n, Row %, Column %, etc.) , page 17). 

Ý The total sample size of the table is 223 (i.e., if there were no missing data, 

each cell would be based on a sample size of 223). 

Ý Each cell has up to 72 missing values (i.e., 223 minus 151). 

Ý The effective sample size is 156 (this is computed on the largest base n of 

215).  In most instances, weighting c auses a decrease in the statistical 

significance of results.  The effective sample size is a measure of the precision 

of the survey (e.g., even if you have a sample of 1,000 people, an effective 

sample size of 100 would indicate that the weighted sample is no more robust 

than a well-executed, un-weighted, simple random sample of 100 people).  

Ý The weighted sample size of 223 has the same precision as an un-weighted 

sample of 70% the size (i.e., 156 / 223)  for this table . 

Ý The percentage shown in brackets indicates the ratio of the effective sample 

size to the total sample size.  A score of 100% indicates that the weighting has 

caused no loss of precision. 

Ý The final statistic (80% filtered out ) shows the proportion of the total number 

of observations in the study that is not available for the analysis due to a filter 

having been applied to the table . 
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Weights, sample size and population  

In commercial market research, weights generally have two roles: to correct for bias 

in the sampling (e.g., over -representation of a particular segment) and to gross up 

the sample size to match known population totals (e.g., the number of people in a 

country).  Q accommodates both of these roles.  When a weight is applied, all 

percentages and averages automatically take the weight into account.  Estimates of 

the population size can be obtained by selecting Population from Statistics ï Cells, 

Column Population in Statistics ï Below and Row Population in Statistics ï 

Right. 

Making variables available as weights  

Any variable in the data file with the name of weight will 

automatically be available as a weight. 

Any non-text variable can be used as a weight by right-clicking on 

the variable in the Data tab and selecting Available for Weighting.  

Alternatively, check the weight tag in the Variables and Questions 

tab ( ).  This makes it appear in the weight drop -down at the 

bottom of the screen in the Tables tab. 

Creating weights  

Any Pick One question can be used to create a target weight. To 

create a weight: 

Ý Go to the Variables and Questions tab, right -click, and select Insert 

Variable(s) and Weight... 

Ý Select the question that you wish to set targets for from the Target 

question(s) drop-down menu. 

Ý Select whether you wish to set target s based on percentages or counts by 

clicking the buttons for Percentage % or Population/Count in the Target 

numbers section. 

Ý Enter the desired targets for each category into the relevant cells in the 

Targets section, as shown in Figure 19. 

Ý Click OK. 

Automatic  

Taggin g 

variables as 

weights  

Using one  

variable  
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Figure 19. Creating a simple target weight based on gender 

It is also possible to create a weight f rom a combination of 

questions. For example if you want to weight by age and gender , 

then weights need to be set for each combination of categories 

from your age and gender questions. There are a number of ways to go about this in 

Q. 

If you know which targets you want to set for each category combination  (e.g., males 

18 to 24) , then the weight can be created by selecting multiple questions from the 

Target questions and Target Column Questions drop-downs in the Weight set 

section. This will produce a larger number of cells in the Target numbers section ï 

one cell for each combination of categories from the selected questions ï into which 

you can enter the desired targets.   

In some cases, appropriate targets for the combinations of categories in the questions 

that you wish to weight by are not available.  Once you have targets entered for a 

single question according to the method above for Using one variable, press the Add 

Weight Set button, select a question from the Target questions drop down in the 

second weight set, and then enter the targets for this question .  The weights are 

computed using raking (also known as rim weighting ). 

Weights  with 

multiple  

variables  
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Sometimes it may be necessary to apply target weights to a number of sub -groups of 

the sample as well as to the total sample.   For example, you may want to separately 

compute and apply weights to each wave of a tracking study .  If this is the case, you 

can select an appropriate Date or Pick One question from the Recompute for each 

drop-down. When a Date question is selected, the weighted proportions will be the 

same in each time period. When a Pick One question is selected, the weighted 

proportions will be the same when you filter by any of the categories from that 

question. 

Pressing Diagnostics Report will cause Q to check the validity of your weights, 

inform you of an y problems, and present information about the final calculated 

weights. 

You can paste targets that have been copied from Excel using the  button. You can 

copy the targets by pressing . 
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Filtering  

I t is often useful to view data for only a su bset of a sample of respondents; this is 

called filtering.   

In this chapter you will learn how to:  

Ý Create a simple filter.  

Ý Create a complex filter. 

Ý Quickly create lots of filters. 

Ý Apply a filter.  

Ý Remove a filter. 

Creating simple filter s 

 

Figure 20.  Selecting cells for filtering 



Q QUICK START GUIDE    

 

28  

To create a simple filter:  
 

Ý Create a table which shows the data you wish to use to construct the filter.  For 

example, to filter the data to base analyses on only Males aged 25 to 44, you 

should select age and gender in the blue and brown drop -down menus.   

Ý Select the cells representing the respondents you wish to include in the filter.  

For example, to filter males aged 25 to 44 select the cells as shown in Figure 20.  

Ý Press the Create new filter button ( ). 

Ý Enter your desired name for the filter.  It is a good idea to give filters names 

that will be easy to recall and will be meaningful to others using Q or reading 

tables and charts generated by Q (e.g., Males 25 to 44 is a good name for this 

filter).  

Ý If you do not want the filter to be applied to the table you are viewing, ensure 

that Apply filter to the current table is not checked in the dialog box. 

Ý Press OK.   

 

Figure 21.  Table with filter applied  

Figure 21 shows the table with the filter applied, with NaN  in many of the cells not 

included in the filter.  NaN  means Not a Number; in this instance, the females have a 
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sample size of zero after applying the filter so percentages cannot be computed. 

However, zeros do appear in the column for males as the total sample for men is sti ll 

greater than zero. If we change the variables in the brown and blue drop-downs, the 

filter will remain selected.  

Creating complex filters  

More complex filters can be created by: 

Ý Applying multiple filters to a table.   Each time you apply a filter to a table  

using a filter drop-down at the bottom of the Tables tab, another filter drop-

down will appear to its right so that you can easily apply further filters to the 

same table (in Figure 21 the first filter is Males 25 to 44, followed by AND with a 

second filter menu showing Total Sample). 

Ý Constructing new variables as filters.  The fastest way to do this is to edit an 

existing simple filter. Apply the filter to a table, click the yellow  to the left 

of the first filter drop -down, right click on the highlighted variable  and select 

Edit Variableé. Create Boolean expressions using the ,  and  

buttons. Add and remove filter terms using the  and  buttons. Select 

the question (or variable) you wish to use from the list of Variables and 

Questions and select the appropriate categories from the Contains and 

Values box. This is discussed in more detail in the Q Reference Manual and 

Online Training. 

Quickly creat ing  lots of filters  

You can quickly create lots of filters as follows:  

Ý Create a Banner question, selecting all the questions that are wanted as filters 

so that they are side-by-side (see Creating Banner Questions, page 21). 

Ý Press , to the right of the blue drop-down menu (which should have the 

newly-created banner question selected in it).  This causes the variables in the 

banner question to be selected in the Variables and Questions tab. 

Ý Make all of the selected variables available as filters by clicking on the Filter tag 

( ).  It may also be useful to hide this question (press ) so that it does 

not appear in the blue and brown drop-down menus. 

Ý Review the Label column of the selected variables if you wish to reword the 

descriptions of any filters. 
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Ý Right-click on any variables with the word NET appearing in the label and select 

Delete Copied or Constructed variable(s) (as having a filter which is a NET 

makes no sense, as it will be 100% of the sample).   

Applying filters  

Once a filter has been created, it can be applied to any table using the Filter drop-

down on the bottom -left of the screen.  

There are two ways of seeing that a filter has been applied.  First, the drop-down 

displays the name of the filter with a green background.  Second, the description of 

the sample size at the base of the screen also shows whether or not a filter has been 

applied (see Figure 18, page 23).   

Removing a filter  

To remove a filter, go to the Filter drop-down and select Total sample or press . 
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Creating reports  

This chapter provides an overview of how to produce reports of your findings.  In this 

chapter you will learn how to:  

Ý Create a report, which is a collection of tables.  

Ý Organize a report. 

Ý Lock tables so that they cannot be accidentally changed. 

Ý Change multiple tables at once. 

Ý Automatically generate reports. 

Ý Create text pages.  

Saving tables  

Each project contains a Report  into which tables are saved.  A report is a collection of 

tables that you can view at a later time. An example of a report (containing 4 tables) 

is shown in Figure 22.   

 

Figure 22.  A report containing four tables 
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To add a table to the report , press the  button to the top -left of the table .  This 

saves the current table and adds a new table immediately beneath it in the report.  

The new table, which is a copy of the saved table, is now displayed.  The highlighted 

table in the Report  indicates which table is being viewed. 

Organizing reports  

By right-mouse-clicking anywhere on the report you obtain a menu that you can use 

to create Groups (i.e., folders to organize your report), del ete tables and rename 

tables.  Similarly, you can drag and drop tables and groups of tables to reorganize the 

report.  

Locking tables  

Often it is useful to lock  a table to prevent users from inadvertently modifying it by 

formatti ng it or changing the selections in the blue or brown drop -downs, the weight 

menu, or the filter menu.   This is done by right-clicking on the table in the Report and 

selecting Lock from the menu.  To unlock, simply right -click on the table again and 

select Unlock. 

If the data is modified, either by importing new data, recoding data or merging 

together the same questions in a different table, the data shown in the table will 

change irrespective of whether the tables are locked or not. 

Changing multiple tables at the same time  

You can use your Shift and Ctrl keys in conjunction with your mouse to 

simultaneously apply operations across multiple tables at any one time (e.g., applying 

weights and filters, selecting questions, setting footers, locking, exporting, printing, 

and selecting statistics). 

Showing and hiding a r eport  

If not already visible, a report can be viewed by positioning your mouse over the left 

border of the screen until the arrow turns into a double -headed arrow with a line 

through it, then holding your left mouse button down and dragging the border out 

until your screen looks like Figure 22. The left of your screen will display the Report.   

The report is hidden by dragging the  splitter back to the left.  
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Worked Example 3: Creating reports  

1. From the File menu select Open Existing Projecté and open Phone 1.Q , which 

will be in c: \ Program Files \ Q\ Examples  (unless Q has been installed in a 

different location on your computer) . 

2. Select Q6. Aided Awareness in the blue drop-down, and BANNER in the brown 

drop-down. 

  

Figure 23.  The Report Tree 

3. Press the  button to the top -left of the table.  You will see that the Report on 

the left of the screen (see Figure 23) shows two separate tables, which at the 

moment are identical; they are both showing Q6 by the banner question.  

4. Click in the blue drop-down, type q4 and select q4: Age.  Note that the second 

table in the Report has now changed to show q4: Age by BANNER.   

5. Click on the first table in the tree.  Observe how we are now viewing Q6. Aided 

Awareness in the blue drop-down again. 

6. Position your mouse over q4: Age by BANNER in the Report.  Right-click and select 

Lock.  A padlock will now appear in the Report next to the table ï once a table is 

locked it cannot be changed by the user. This prevents accidental changes to 

tables (but note that table content will still change if data or any question/s shown 

in the blue or brown drop -downs are modified elsewhere). 

7. To unlock the table, right -click again over it in the Report and select Unlock.  

8. Right-click on Report. This time, select Add Group. Q has created a subfolder 

called Group 1 into which you can organize various reports. 

9. Change the name of this group to Awareness. You can add to tables to groups by 

dragging and dropping the tables into the group subfolder.  
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Basic Tables  

Basic Tables is a feature for automatically generating a Report containing a large 

number of tables. 

Basic Tables are created as follows: 

Ý Select Basic Tablesé from the Create menu. 

Ý Select the key questions of interest as Key questions.   

Ý I f you want to cross -tabulate these questions by other profiling questions (e.g., 

by age and gender), select these other variables as Profiling questions. 

Ý Press OK. 

Ý If you wish the tables to contain non -default statistics, select the tables in the 

report and then select the desired options. For example, a table of last brand 

consumed by age group will, by default, only show column percentages; if you 

wish your table to show percentages and counts you would check each of n, 

Row % and Column %. 

These tables can then either be viewed directly in Q, exported to Word, PowerPoint or 

Excel ( ), printed or exported as a PDF (File ¤ Export to PDFé). 

Text pages  

Text pages can be added to a report by selecting Create ¤ Text.  By default, these 

are setup with very large font sizes for exporting to PowerPoint or dashboards.  

However, you can change the default appearance of the text by selecting Edit ¤ 

Project Optionsé ¤ Text Items. 

Making notes  

Notes about a project can be stored in the Notes tab (see the bottom left of the 

screen).   

Notes about a specific table can be stored with the table by right -clicking, selecting 

Table Optionsé and entering the notes in the Notes box. 

Notes can be attached to individual variables in the Variables and Questions tab by 

right-clicking on the variable and selecting New Comment for Variableé. 
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Plots  

This chapter provides an overview of how to create plots in Q.  Q can also create plots 

using Excel, Word and PowerPoint, as described in Export to Office (see page 38).  

Creating a plot  

A table is turned into a plot, and vice versa, using the Show Data as drop-down in 

the toolbar. The main plot types are shown in Figure 24. 

Modifying a plot  

If you wish to merge categories or rename categories in a plo t, first change it back 

into a t able and make the desired changes. 

A plot is formatted by right -clicking on the part of the plot you wish to change and 

selecting from the available options.  If you want to change the appearance of a 

specific part of a plot, such as changing a series from a line into columns, first select 

the relevant part of the plot (by left -clicking) and then right -click to see the available 

options.  For example: 

Ý To change the font of an axis, click on the axis, right -click and select Format X 

/ Y axisé, and then click on the text that  says  Gridlines are 

also added in this dialog box. 

Ý To add the values to a plot for a series, right -click on the bars/lines of the 

series, select Format Data Seriesé and check Label points. 

Ý To specify which date periods are to be included in the columns of a Column 

plot with trend, right-click on the plot and select Format All Seriesé ¤ 

Categorical Period. 

Ý To turn a column plot into a snake plot, create a Bar/column/line plot, r ight-

click on it and select Swap X and Y Axes, right -click and select Format Data 

Seriesé and change the Plot type from Column to Line. 

Ý When creating a Stacked column/bar plot, the position of the bars relative to 

the axis is determined by the Value (which is set by right clicking on the 

relevant categories in a table and selecting Valuesé).  Positive values appear 

above the axis, negative below and 0 values are shown in a separate table 

underneath the plot.  
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Additional information about the Time series plot, Column plot with trend  and Trend 

plot can be found in the Q Reference Manual. 

Standardizing the look of  your plots  

Select Edit ¤ Project Options ¤ Plots to set default colors and fonts.   You can drag 

a plot from on e project to another and it will remember its formatting (note that if you 

are using the default colors, the plot will apply the default colors of the new project ; if 

you have merged categories together or created NETs, they will not be copied over).  

Additionally, save a plot as a template by selecting View ¤ Save as Templateé. 

 
Bar/column/line plot 

 

 
Column plot with trend  

 
Grid of bars 

 
Histogram 

 
Scatterplot 

 
Stacked column/bar plot 

Time series plot 
 

Trend plot 
Figure 24.  Plot types 
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